Contents

PERFORMANCE ................................................................. 5

INTUITIVENESS ............................................................... 6
  Surface Painter ............................................................ 7
  Snap Points and Guide Lines ......................................... 9
  Mac Interface: Unified Window Mode with Docking Palettes .... 13
  Tab Bar on Windows and Mac .......................................... 15
  Expanded Surface Catalog .............................................. 17

DOCUMENTATION ........................................................... 18
  Dimensions Improvements ............................................ 19
  Label Improvements ................................................... 25
  Publish Layers to PDF from Layout .................................. 28

SCHEDULING ................................................................. 29
  List Skin/Component Area in Interactive Schedule ............... 30
  Schedule of Finishes .................................................. 31

OPEN BIM ..................................................................... 34
  Displaying Point Clouds ............................................... 35
  IFC Import Improvements ............................................ 36
  MEP Improvements ..................................................... 40
  BIMx Export Improvement ............................................ 42

TEAMWORK AND BIM SERVER ............................................. 43
  BIMcloud Control Icon: Single Entry Point for Server Management .... 44
  Network Diagnostic Tool ............................................. 45
  BIMcloud Tray Application: Single Entry Point for Server Management .... 46

LIBRARY IMPROVEMENTS .................................................. 47
  Simplified Door/Window UI .......................................... 48
  New and Enhanced Library Parts .................................... 50
  New and Improved Label Types ..................................... 54
  Other Library Part Improvements ................................... 56

SMALL INTERFACE CHANGES ............................................ 60
PERFORMANCE

New Background Processing for Nearly Instant Model Views

With background processing, ArchiCAD 19 takes advantage of the processor’s unused capacity to build up different model views in advance. Background processing also utilizes your hardware more efficiently. Enjoy a smoother workflow and a lot of saved time!

- Open model windows (or tabs) are always kept up to date
- Much faster switching among 3D, 3D Document, Section/Elevation/IE-type views
- No waiting for rebuilds - if you open a view by mistake, you no longer have to wait for it to rebuild before switching to a different view
- Page through layouts that contain auto-rebuild drawings without delay
- See feedback on background processing in your status bar (click to suspend as needed)
- Work Environment option for Power Save mode: Suspend background processing feature if you’re using a battery-powered device

See also Background Updating in the ArchiCAD Reference Guide.

Optimized OpenGL Engine for Smoother, Faster Navigation

For working in 3D and for informal client presentations, most users turn to ArchiCAD’s built-in 3D window with the OpenGL engine. OpenGL provides fast navigation in 3D views that are always up to date, and allow co-design with the client.

- As of ArchiCAD 19, an optimized OpenGL engine means that 3D navigation will be smoother and faster, free from flickering, even with big models.
INTUITIVENESS

Surface Painter
Snap Points and Guide Lines
Mac Interface: Unified Window Mode with Docking Palettes
Tab Bar on Windows and Mac
Expanded Surface Catalog
Surface Painter

Use the new Surface Painter palette to change element surfaces (either model elements or GDL objects) in the 3D window. With Surface Painter, creative design is instantaneous, and makes for impressive presentations.

“Paint” Elements Directly in 3D

- Pick a surface from Surface Painter (or pipette a surface from a 3D element), then click on an element to paint it

- Another workflow: select any element(s) in the 3D window to add them to Surface Painter’s selection list. Double-click to access and modify their Surface Settings.
- Alternatively, use the two lists in Surface Painter to override surfaces: choose a surface (from the content list) and click another surface (from the selection list) to override that model selection (or use drag and drop to achieve the same)
The *Select All Elements Using Surface* context menu command, from a selected Surface in Surface Painter, will get all the model elements which use it

- **Remove All Surface Overrides** command strips elements (selection or entire model) down to their Building Materials (construction elements only)

**Feedback in Paint Mode**

Any time you select a surface from Surface Painter, you enter Paint Mode, providing special feedback as you move your cursor in the 3D window:

- Targeted element surface(s) are highlighted
- Element surface changes temporarily, giving you a preview of how it will look after you paint it
- Info Tag provides graphical and written info on which surface will replace which
- Tab through multiple element faces: paint all surfaces of an element, or just certain faces

**Manage Surfaces with Surface Painter Palette**

- Use Palette’s search function to identify the right surface
  - Option to narrow search to project attributes, surface catalogs, or BIM Components
- From web or catalog, add a surface to the project with one click
- Double-click a surface preview to open Surface Settings, or use its context menu
- Customize the palette view to fit your preferences
  - Previews in OpenGL or CineRender
  - Small/Medium/Large icons
  - Horizontal or vertical arrangement

*For more details, see Override Surfaces With Surface Painter in the ArchiCAD Reference Guide.*
Snap Points and Guide Lines

ArchiCAD 19 has overhauled its Guide Lines function to better match the way you work, making precise input even more intuitive.

- The new Snap Guides give you on-the-fly input help when and where you need it;
- while the Guide Lines are placed by you, and stay put until you remove them.

The Snap Points feature (formerly Special Snap Points), expanded with a useful new option, works together with Snap Guides.

Snap Guides: Instant, Smart, Temporary

- Relevant Snap Guides (lines or arcs) are offered automatically during your input (you don’t have to click to find them), based on the current context
- To generate additional relevant Snap Guides, define additional Snap References (points or edges), simply by hovering (or click Q for an instant Snap Reference)
- Use a Snap Reference point as a temporary input origin: a distance entered in the Tracker is measured from this point. For example, to place a window at 60 cm. from a corner, just define that corner as a Snap reference point. Input 60 in the Tracker’s Distance field, and click to place the window.
- Multiple Snap Guides, originating from multiple elements or references, can be used at the same time (no need to choose just one “active” line)
- After you are done with the current element input, the Snap Guides disappear immediately

For more details, see Snap Guides in the ArchiCAD Reference Guide.
Permanent Guide Lines

Introducing permanent Guide Lines familiar from major DTP applications.

- Drag a Guide Line into the model window from the side of the window (like the cutting plane) to create a Guide Line (or circle) wherever you choose - at a point or edge, or in empty space
- Draw a Guide Line segment anywhere with two clicks
- Guide Lines stay put until you explicitly delete them
- Option to hide all Guide Lines temporarily, or erase any of them graphically

For more details, see Guide Lines in the ArchiCAD Reference Guide.
Improved Snap Points

- A new Snap Point option is born: “best division to distance”
  Provide a distance value, then hover over the full length element. The ideal division will be automatically calculated, producing equal parts as close as possible to the distance you specified.

  Here, we used the new snap point option to place columns along a slab so that they are roughly 1500 apart, equidistant, and with no “piece” left over at the end.

- Enhanced Snap Point feedback shows starting point from which the element is marked

- Snap Points located along a temporary Snap Reference segment remain visible as long as that Reference does. Even if you start editing at the other end of the Snap Reference, the Snap Points you defined are still visible.
• Entire Polylines can be treated as a single unit, so you can use Snap Points along them intelligently

*For more details, see Snap Points in the ArchiCAD Reference Guide.*
Mac Interface: Unified Window Mode with Docking Palettes

The unified-window ArchiCAD interface is now implemented for Mac (already available on Windows), with support for Full Screen mode.
- Resize the entire ArchiCAD interface easily
- Switch to full screen mode with only one click
- Palettes can be docked/undocked in the main ArchiCAD interface, so users won’t get lost in the interface of other running applications, or have their window headers disappear behind palettes
- Mac only: Undock windows and move to separate displays
- Mac only: Access the project’s file path from the application header
- More consistent interface between platforms means easier transfer of Work Environment

See also Unified Window Mode on Mac and Dock or Undock Palettes or Toolbars in the ArchiCAD Reference Guide.
Other Workspace Improvements

- Show/Hide All Palettes with one-click menu command
- Change your Work Environment Profile more easily, with a menu command instead of the Work Environment dialog box (Options > Work Environment > Apply Work Environment Profile)
Tab Bar on Windows and Mac

Switching among different open windows is now easier and faster than ever! ArchiCAD 19 introduces the Tab Bar, placing any number of opened windows at your disposal. The design is specific to each OS.

**Tab Bar on Windows**

**Tab Bar on Mac**

- Switch among model windows faster: Tab Bar takes advantage of background processing, introduced in ArchiCAD 19
- To open more model windows, use the new pop-up navigator from the Tab Bar - faster navigation without the Navigator Palette

**Pop-up Navigator for Easy Switching**
• Each tab has relevant context menu commands enabling quick access to related views or settings

![Image of ArchiCAD window]

**Story Tab: Open any other story**  **IE Tab: Open another IE from the group**

• Picture window tab provides feedback on background rendering progress (CineRender only)

![Image of ArchiCAD window]

• Tab icon will indicate whether it’s a view (yellow) or viewpoint (orange) and if the view does not match the current settings (warning icon)

• Double-click the tab (or use tab’s context menu) to restore the view’s saved status

*For more details, see Tab Bar in the ArchiCAD Reference Guide.*
Expanded Surface Catalog

In ArchiCAD 19, the automatically loaded Standard Surface Catalog has been expanded to include a much wider array of popular surfaces.

In all, the Standard Catalog now contains more than 500 surfaces - that is, 200 more than in ArchiCAD 18.

• New surfaces have been added, based on user request
• Many surfaces previously available as premium content are now standard, available to all users
• Surfaces that earlier were saved in local templates are now in the Standard Catalog
• Find the Surface you need more easily: keywords have been added to every surface for smarter searches
DOCUMENTATION

Despite the freedom of 3D design, the architect’s job always culminates in detailed 2D documentation. Every tool that supports this documentation means more time available for creative design.

The latest improvements in ArchiCAD’s documentation tools will speed up your daily, repetitive annotation tasks, and ensure proper appearance of dimensions and labels automatically, with fewer manual adjustments.

**Dimensions Improvements**

**Label Improvements**

**Publish Layers to PDF from Layout**
Dimensions Improvements

Automatic Pointers for Easy-To-Read Dimensions

Dimensioning narrow structures close to each other can make it difficult to read plans, because the dimension numbers are too crowded. Until now, users have solved this by dragging the dimension texts away and using a manual pointer to connect them to the referred element. Of course, if any such text item was later moved, you had to readjust the line, too, by hand.

The new Pointer for Dimension Texts in ArchiCAD 19 eliminates this extra work:

- Add a Pointer line to any dimension text
- Pointer line is added automatically when dimension numbers are moved out of area
- Pointer lines are associative and follow every change

Dimension Text Pointers work like labels, with all their formatting possibilities.
**Dimension Texts: Right Where You Want Them**

ArchiCAD 19 introduces new options to control the placement of dimension texts – e.g. to place texts underneath the dimension line automatically whenever necessary, and/or allow them to shift laterally. Choose the dimension placement logic that you prefer.

See also *Placement of Dimension Text in the ArchiCAD Reference Guide.*

**Easier Editing of Dimensions**

Point-specific new pet palette commands make it easier to edit Dimension points, text boxes and Pointers graphically.

- **Split** dimension into parts with just one click
• **Break and offset** dimension line

![Image of Break Dimension Line](image)

• **Move Dimension Point** (with visual feedback on the dimensioned point)

![Image of Move Dimension Point](image)

• **Edit Length of Witness Line** (new option for graphical editing)

![Image of Edit Length of Witness Line](image)

• Edit starting angle of all Pointer lines through Dimension Settings
• All graphical editing commands (e.g. Drag, Stretch) available for Pointer line (as for Label Pointers)
Automatic Dimensioning of Story Level Lines

Dimension a whole skyscraper with just one click.

- In Section/Elevation view, click with the Dimension tool on any single Story Level Line
- After a story level change, all vertical dimensions are rebuilt automatically
Multi-line Dimension Texts
In earlier versions, if you needed several lines’ worth of dimension text, you had to add a separate text box, unconnected to the dimension.
As of ArchiCAD 19, you can add as many lines of dimension text as you need. The full dimension text can be formatted and shifted around as needed, without falling apart.

New Witness Line Option
With ArchiCAD 19, you can choose witness lines with no overhang, required for documentations in some markets.
**Associative Level Dimensions**

Level Dimensions automatically become associative to the clicked element (Slab/Roof/Shell/Mesh).

You can filter the types of elements further, by using Gravity.
Label Improvements

Add Multiple Labels to Any Element

As of ArchiCAD 19, you can link any number of labels to each element - even elements in Hotlinked modules. This feature gives you much greater freedom to label any element as needed. For example:

- Label a single element with several properties - e.g., to show both “fire rating” and “ID” for the same Wall
- Place the same label several times along a long Wall
- Place the same label at different scales and in different sizes as needed
- On a multi-story element with varied geometry (such as a slanted Wall), place a label at a different position on each story
- Label elements of a Hotlinked Module within the host file
Easier Label Placement

Until now, you had to place associated labels using element settings, after setting a default label separately for each element type.

From now on, just use the Label tool: choose the desired Label type (which becomes the one single Label default, until you change it), then click any element. No need to open the labeled element’s dialog box.

- Element highlight helps you label the right element
- Tab to switch among overlapping elements (including Curtain Wall sub-elements)
- Label multiple elements simultaneously, regardless of element type (using Document > Document Extras > Label Selected Elements). The current default label type is attached to all selected elements
- Label Curtain Wall sub-elements directly
• New Inverted Pointer option for labeling in sections: e.g., for displaying the bottom elevation of suspended ceilings

![New Inverted Pointer option](image)

**Smarter Editing of Labels and Pointers**

• Select and drag several Labels simultaneously; Pointers are adjusted accordingly

![Smarter Editing of Labels and Pointers](image)

• Edit starting angle of all Pointer lines through Label Settings
• Lock starting angle of all Pointer Lines to ensure a consistent throughout documentation
• All graphical editing commands (e.g. Drag, Stretch) available for Pointer line (as for Pointers of Dimension texts)
• Turn Pointer on/off for all Labels of a given type (e.g. all ID labels)

**New Label Objects**

To fit the new Label workflow, the ArchiCAD 19 Library includes many new Label types.

See also New and Improved Label Types in this document.
Publish Layers to PDF from Layout

ArchiCAD 19 lets you export layouts (not just model views) with their drawing layers to PDF format. In the resulting PDF document, you can show or hide content by layers, or navigate among layers.

Whether you are publishing model views or layouts, what you see is what you get.
SCHEDULING

List Skin/Component Area in Interactive Schedule
Schedule of Finishes
List Skin/Component Area in Interactive Schedule

When compiling a bill of quantities, users can now list all components, regardless of which ArchiCAD tools were used to model them.

- Schedule the areas of any composite structure by skin
- Schedule the areas of profile elements by components

For example, you can easily list the areas of thermal insulation panels.

For more details, see Skin Areas of Basic and Composite Elements and Component Areas of Complex Profiles in the ArchiCAD Reference Guide.
Schedule of Finishes

Newly introduced Surface Lists let you schedule the total exposed area of a surface (as well as their other properties, e.g. color or hatching).

You can define exactly what counts as exposed, depending on your Surface List Scheme Settings. In the follow diagram, the dark blue area is considered as “Exposed”, the light blue areas are considered as “Covered”.

However, you can define the light blue areas to be calculated as exposed - e.g., if they are behind furniture objects. The “Reduce Exposed Area” sub-dialog (in Scheme Settings, from the “Exposed Area” field) can specify, for example, “Element Type is not Object”. This way, the light blue area is also counted as Exposed Area.
These schedules provide a fast and precise list of the areas of required finishes (paint, wallpaper, wall coverings etc.).

- **All Finishes** lists every visible surface in the model with its total exposed area.

<table>
<thead>
<tr>
<th>Name</th>
<th>Exposed Area [m²]</th>
<th>Color Sample</th>
<th>Color [R,G,B]</th>
<th>Paint</th>
<th>Matching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ar</td>
<td>6.56</td>
<td></td>
<td>255,255,255</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Brick - Red</td>
<td>200.62</td>
<td></td>
<td>224,102,57</td>
<td>Brick - Running Bond</td>
<td>Background</td>
</tr>
<tr>
<td>Concrete - 02</td>
<td>15.69</td>
<td></td>
<td>168,169,156</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Concrete - 10</td>
<td>8.74</td>
<td></td>
<td>96,96,96</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Insulation - Fiberglass</td>
<td>3.47</td>
<td></td>
<td>255,255,186</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Paint - Light Gray</td>
<td>35.21</td>
<td></td>
<td>168,168,168</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Paint - Light Gray</td>
<td>76.37</td>
<td></td>
<td>168,158,166</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Paint - Pale Blue</td>
<td>127.56</td>
<td></td>
<td>162,197,215</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Paint - Sand Beige</td>
<td>76.00</td>
<td></td>
<td>195,196,163</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Paint - Titanium White</td>
<td>29.03</td>
<td></td>
<td>255,255,255</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Stucco - White Fine</td>
<td>651.10</td>
<td></td>
<td>243,245,239</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Wood - Oak Light</td>
<td>384.42</td>
<td></td>
<td>284,167,82</td>
<td>Background</td>
<td></td>
</tr>
<tr>
<td>Wood - Fine Grained Horizontal</td>
<td>37.36</td>
<td></td>
<td>237,217,184</td>
<td>Background</td>
<td></td>
</tr>
</tbody>
</table>
• **Finishes of Construction Elements** lists the visible surfaces used by each element type, with their respective exposed areas.

You also have the schedule specify whether the listed surface differs from that of the element’s Building Material surface - i.e., whether it has been “painted over” (here, the Painted checkbox).

![Finishes of Construction Elements table]

- **Finishes of Openings** lists the surfaces (excluding glass) of Doors and Windows. That is, the schedule lists the surfaces used for frame, casing, and accessories such as shutters, board, and sill).

![Finishes of Openings table]

*See also Create Schedule of Surfaces in the ArchiCAD Reference Guide.*
OPEN BIM

Displaying Point Clouds
IFC Import Improvements
MEP Improvements
BIMx Export Improvement
Displaying Point Clouds

Projects involving renovation typically require digital modeling. For this purpose, 3D scanners generate point cloud files, such as a historic room interior with all its volutes and ornaments. Now such point cloud files can be placed in your ArchiCAD model, for a smoother renovation workflow that is in tune with the BIM concept.

- Open .xyz and .e57 file formats and convert them into native GDL-like objects, which are placed, in the correct sizes and colors, on the Floor Plan or in the 3D window
- Snap to any point on the resulting object
- Align existing building model to point clouds
- Use point cloud as an aid when modeling a new building in ArchiCAD - no need to start drawing from scratch

Use the point cloud workflow to model existing buildings prior to renovation; surroundings and neighbor buildings, as an aid to visualization; or the “as-built” building, to detect any deviations from the planned state.

Image credit:

For more details, see Working with Point Clouds.
IFC Import Improvements

**Exact Geometry Import**

Since the introduction of priority-based connections and Building Materials, connecting elements automatically affect each other’s geometry based on their priority. As of ArchiCAD 19, users have the option to avoid this when importing an IFC model. This way, they can see the model exactly as it looked in the original authoring tool, and no auto-intersection is used.

- Imported IFC model space elements (IfcSpace) will always be generated as ArchiCAD Zones, which will always retain the imported elements’ original geometry
- Import functions (Open, Merge, etc.) ensure that the imported elements will always be displayed in their original colors
- Option to use Object or Morph tool to generate imported building, MEP or other element
- New IFC translator for “Exact Geometry Import” is provided in the template
Attribute Handling for IFC Import

- Ability to override materials and representation styles of IFC model elements with preset Building Material and Surface Attributes. This will lead to much cleaner project files, because the IFC model’s attribute set won’t be recreated unnecessarily.
- Intelligent template for converting IFC Materials to Building Materials: the list of mapped IFC materials can be easily expanded based on IFC file content.

In this example, the Material and Surface Conversion overrides the original materials and surfaces of the imported IFC model, with concrete elements in blue and steel elements in red.

ID Management of IFC Spatial Elements

Smart ID assignment is now available in ArchiCAD’s Project Info fields for Project ID, Site ID and Building ID.

You can use keywords added to the Project ID, Site ID and Building ID fields to control whether the IFC spatial elements (IFC Project, IFC Site, IFC Building) are assigned identical or different GlobalID values - even if they are located in projects created with a single template.

For example, you can ensure that two buildings located on a single site will have different GlobalID values.
Improved Import of MEP Models

When importing MEP elements, ArchiCAD now optimizes the management of shared geometry. As a result, the import will produce fewer geometric elements (in the case of Morphs) and fewer Library Parts (in case of Objects).

In ArchiCAD’s MEP Modeler environment (an optional add-on), the program

- can convert MEP Modeler-type elements from all MEP elements of an imported IFC model, and
- can automatically detect and calculate an insulation parameter (where needed) for imported pipe and duct items.

MEP elements will be imported with their original color.

Update with IFC Model

The “Update with IFC Model” command has been expanded with new and customizable functions. Choose your preferred option:

- Generate only the new properties
- Update the existing properties with any changes
- Delete unused properties from the ArchiCAD project
- Do a total update using all three of the above options

In addition, you can use the Model Filter option to set which element types’ properties (e.g. just the columns, or just the elements on a particular story) should participate in the update.

In this example, the update process adds the new properties of Beams and Columns, which are found both in the IFC model and the current ArchiCAD project.
Streamlined IFC data mapping of Library Part Parameters

New option in IFC Scheme Setup: if a particular parameter is common to several Library Part elements, you can map its corresponding IFC data in just one step.

In this example, the “FM_SerialNumber” parameter is mapped to the “SerialNumber” IFC property as Library Part Independent. This means that any IFC element that is generated by a Library Part (Window, Door, Object, etc.) is assigned the value of this parameter, provided that the element includes this “FM_SerialNumber” parameter.

Export IFC Data to BIMx

You can control which element information will be published as part of your Hyper-model, to be viewed in BIMx apps on mobile devices.

One option is to export each element’s IFC properties, as defined in the Tags and Categories panel of its Element Settings dialog box.

See also BIMx Export Improvement in this document.

Improved IFC Performance

Faster IFC data handling in IFC Manager.

API IFC Improvements

Add-Ons developed for ArchiCAD can now, in runtime, assign IFC attribute, property and classification data to elements and product types.

This feature also allows the Add-Ons to define mapping between their custom data and IFC data with simple and complex rules.
MEP Improvements

Improved Collision Detection in MEP Modeler Environment

Collision detection now works for all elements classified as MEP-type in Element Settings (Tags and Categories > Element Classification), and not just for MEP Modeler elements. As a result, collision detection works on:

- all imported IFC MEP elements (regardless of which MEP application exported the IFC model), and
- all ArchiCAD project MEP Objects and MEP-classified elements (for example, pipes defined with Beam tool, but classified as MEP elements).

The collision detection function works between solid and solid and between solid and open shell geometries.

For improved performance, collision detection works on a multicore basis to avoid slowdowns, and the algorithm itself is now much faster than in previous versions.
Element Classification Available for MEP Elements

Unique element classification (Element Settings > Tags and Categories) can be set for Ductwork, Pipework and Cabling elements and equipment in the MEP Modeler environment. This means you can classify an element in a way that best conforms to IFC element classification and IFC model export.

Element Classification has another advantage, not directly related to IFC exchange:

- Search for MEP elements by using specific “Element Classification” values as criteria
- List MEP elements according to their element classification, in the Interactive Element Schedule

Automatic MEP Modeler License Reservation

With the MEP Modeler network license, anyone can use the MEP Modeler functions, provided that a license is available.
BIMx Export Improvement

Control Element Info for Mobile Users

When you publish an ArchiCAD project in BIMx Hyper-model format, the file’s recipient, viewing the BIMx model on a mobile device, sees the project’s 3D and 2D information - including certain element information.

Until now, the element information provided in the Info feature of BIMx mobile apps consisted of a predefined set of data.

As of ArchiCAD 19, you can control which element information will be published as part of your Hyper-model.

- When publishing the Hyper-model, use the new Info Set pop-up to define the element info that the recipient will see:

  ![Info Set Pop-Up](image)

  - The **BIMx info** option uses data defined in an Interactive Element Schedule of this name. This schedule is provided in the factory-default ArchiCAD template (for the International market), but you are free to modify the schedule scheme as needed, or to choose a different schedule.
  - The **Tags and Categories** option uses the data defined for each element in the Tags and Categories panel of its Element Settings dialog box.
  - The **Legacy** option provides the same basic element data as in previous BIMx versions.
  - Choose **None** if you don’t want the recipient to view any element information (e.g., if the recipient will just be viewing the model geometry as a whole, and doesn’t need any details on the various component elements).

For more details, see *Use the Publisher to Create a BIMx Hyper-Model*. 

TEAMWORK AND BIM SERVER

BIMcloud Tray Application: Single Entry Point for Server Management

Network Diagnostic Tool
BIMcloud Control Icon: Single Entry Point for Server Management

- New icon in taskbar/menubar means easy access to configuration and management interface
- See and monitor the status of all installed components, and respond quickly to errors
- All management commands are grouped under a single icon
Network Diagnostic Tool

Whether you are accessing server-based libraries, or using BIMcloud/BIM Server for Teamwork on large files, a secure and reliable server connection is imperative for efficient work.

The new Network Diagnostic tool, built into ArchiCAD 19, provides an overview of connections information for all components of your BIMcloud/BIMServer configuration.

- If a connection isn’t working, find out why and how to solve it (using the BIMcloud/BIM Server Manager interface)
- Manually add additional local server paths if needed (supports data transfer over different server paths - BIMcloud/BIM Server Manager only)

BIMcloud Tray Application: Single Entry Point for Server Management

- New icon in application tray (or Mac menubar) means easy access to configuration and management interface
- See and monitor the status of all installed components, and respond quickly to errors
- All management commands are grouped in the tray
LIBRARY IMPROVEMENTS

Please note: Some new Library Part developments are available in certain localized libraries only (where applicable, this is indicated in the descriptions below).

Simplified Door/Window UI

New and Enhanced Library Parts

New and Improved Label Types

Other Library Part Improvements
Simplified Door/Window UI

Graphical Interface: Better than Ever

The controls of Door/Window Settings - until now, overly complex and often redundant - are much friendlier. In ArchiCAD 19, finding and setting Door/Window parameters is more intuitive and therefore much faster.

- All Door/Window parameters are available in a graphical interface on the Custom Settings panel, and grouped into a logical hierarchy
- For fast, simple setup of doors and windows: once you have defined the shape and size, you only need to check the three main tab pages: Door/Window Settings, Wall Opening, and Connecting Structures.
- If you want to set additional details, use the additional tab pages within the hierarchy, or access them with shortcuts from the main pages

- Model (3D) attributes are grouped under the three main tab pages, while all Floor Plan and Section attributes are together on one tab page
- Icons and picture pop-ups have been redesigned

Updated Tab Page Selector

- Smoother workflow: after you navigate to a settings page, double-click to close the tab page selector and then you can edit the settings right away (earlier version required an extra click)
- Back/forward arrows for faster page turning
- Tab page tree view is dynamically resized when re-opened
- Vertically resize the tab pages which contain only a list
More Compact Door/Window Dialog Box

Now that many Door/Window parameters have been restructured, several panels of the Settings dialog box are no longer needed. These have been eliminated or hidden. The result: a more compact interface.

Window Settings Dialog Box in ArchiCAD 18 (left) and ArchiCAD 19 (right)

- No More Parameter List
  Since the custom interface now contains all needed parameters, the Parameter List is superfluous, and has been removed for all doors and windows in the GS library.

- No More Reveal Panel
  The separate Reveal Panel has been eliminated from the settings dialog, but its controls are still available (in the Reveal tab of the new hierarchical structure) for library parts that use these settings.

- No More Model Panel
  In earlier versions, the Model Panel contained few, rarely used controls.
  In ArchiCAD 19:
  - The Model Panel is hidden by default, but can be enabled using the Work Environment’s Tool Settings controls
  - Wall Opening Surface settings have been moved to the Custom Settings panel
  - Undo All Crops command is now at Design > Roof Extras

- No More Listing and Labeling Panel
  As part of the Label Improvements project for ArchiCAD 19, this panel has been renamed to “Listing”, and by default it is hidden in all Tool Settings dialog boxes.

- Improved Floor Plan and Section Panel
  - “Enable Object’s Attributes” was replaced by “Override Object’s Attributes” for a better understanding of the interface
  - Irrelevant settings for all Floor Plan Display types are hidden
  - New icons make it easier to differentiate parameters
New and Enhanced Library Parts

New library parts, or additional types for existing objects, have been created in the ArchiCAD library of the International package.

**Please note:** Some new Library Part developments are available in certain localized libraries only (where applicable, this is indicated in the descriptions below).

Bathroom Accessories

Two new Towel Rack types

- Ring
- Hook
Electrical Hand Dryer Object (3 types)

- Automatic
- Push Button
- High Speed

Towel Rack Radiator Types
LIBRARY IMPROVEMENTS

Playground Elements
- Spring Rider
- Climbing Structure
- Swing
- Slide

Mitred Gutter
New object added to all libraries (already present in USA library).
Three-Sash and Six-Sash Sliding Windows

Note: Not available in the following versions of the ArchiCAD Library: Germany, Austria, Switzerland, Japan, USA.
New and Improved Label Types

The Label tool is significantly improved in ArchiCAD 19. (See Label Improvements, above.) Given the simplified Label placement logic, and the ability to attach any number of Labels to a single element, the ArchiCAD 19 Library contains an entirely new selection of Symbol Labels.

*Note:* Local library content will vary to meet local standards.

- All new Labels have parameters that fit their specific function
- Label Settings for many new labels have been expanded for more control over content and style
For more information, see Symbol Labels and Custom Settings for Symbol Labels.
Other Library Part Improvements

Enhanced Graphical Interface (Selected Library Parts in the International package)

Settings dialogs of selected library parts (see list below) have gotten a facelift in the form of a better graphical interface.

- All parameters available on the more intuitive Custom Settings interface: no more parameters list
- Easier navigation among parameter tab pages
- Better graphics for Minimal Space controls
- Separate tab pages for 2D Representation/3D Representation and Surfaces (formerly all parameters were on a single “Appearance” tab page)
- “Descriptions” tab page replaces earlier “Parameters for Listing”
- New tab page icons

Affected Library Parts

The following library parts in the ArchiCAD Library (International package) have new or enhanced graphical settings pages:

- Special Constructions/Accessory Items: Downspout (+ additional size parameters)
- Beds: Bed, Bed Bunk, Bed Canopy, Bed Double, Crib, Night Table
- Couches and Sofas: Designer Couch, Designer Sofa 01/02/03, Sofa
- On-Site Renewable Systems:
  - Rain Water Tank
  - Solar Collector Evacuated Tube (+ new Water Tank parameter)
  - Solar Collector Flat Plate (+ new parameters for more consistency with similar objects)
  - Solar Photovoltaic Panel
Updated Flat Panel TV
(Formerly: Plasma TV)
- New, graphical interface
- More options for screen size ratios and inputs
- No minimum screen thickness
- Flexible frame width
- More options for stand, base, and mount (e.g. motorized/ceiling/wall mount)

Improved Minimal Space Interface
Clear, multi-color Minimal Space controls for many furniture objects in the ArchiCAD Library (International package).
**LIBRARY IMPROVEMENTS**

**Improved Revision History**

- Show Revision History data in preferred order: list new items from the top down or from the bottom up
- More options for customizing display of Revision History data:
  - Hide unneeded data items using filter control
  - Show only data from latest Revision

**Story Sensitive Controls**

- Floor Plan Display parameter added to wooden trusses for control over story-specific display

- Story sensitive display control added to relevant objects in the USA Library

**Better Control of Zone Text in Zone Stamp 01**

The Zone Stamp 1 object now has the option (like Zone Stamp 02) to set font size by Model Size or Paper Size.
Expanded Parameters for Door Leafs, Sidelights

**Note:** Not available in the following versions of the ArchiCAD Library: Germany, Austria, Switzerland, Japan, USA, Norway, Sweden.

- Door leaf undercut available for all hinged doors
- Door leaf rebate depth parameter for all hinged doors
- 2D opening angle and opening sign for door sidelights
SMALL INTERFACE CHANGES

Apart from thematic feature developments and major performance improvements, ArchiCAD 19 contains a number of fixes, UI changes and renamed controls, all aimed at improving your user experience in small but useful ways. These include the following.

Better Feedback on ArchiCAD Processes
During window updates, library loading and other processes, get improved feedback on what is happening and a clear indication of whether you can stop the process if needed.

3D Window Settings
Updated and simplified UI.
Surface Settings (CineRender engine)
• Choosing “Image” as the Texture type will now automatically open the “Load Image from Library” dialog box
• The two options in the Match Settings popup are renamed to make them clearer: “Update Internal Settings (from CineRender)” and “Update CineRender Settings (from Internal)”

Improved Editing of Image Textures in Surfaces
• The name of each image is listed among the Surface parameters (not just “Image”)
• Texture size (width/height) in pixels is shown in Surface Settings, and when browsing for a texture.
• You now get feedback if a texture is 'Missing' from the library
• If the Surface channels use multiple images textures of varying sizes, you get immediate feedback and the chance to select a proportion for all of them, to avoid distorting the end result

Show Full Element ID in Zone Stamps
• Zone Stamps, Markers and Labels using the Element ID parameter now display the Full Element ID by default - that is, the ID which includes any Master ID information
  • Thus, in a project using hotlinked modules, the Zone ID can be extended by the Master ID of the module instance it belongs to
• The options for displaying element ID in Element Schedules and in library part elements are now renamed as: Full Element ID; Compact Element ID
• No more 15-character limit for the ID field of construction elements (Element Settings > Tags and Categories panel) (new limit is 2048)

Building Material Control for Imported Steel Profiles
In the Standard Steel Profile Database (Options > Import Standard Steel Profile), you can assign a Building Material before importing into Profile Manager.

Composite Structures Dialog Box
• When you drag skins in the list, the dragged skin is placed between skins (instead of swapping two skins)
• When you reopen the dialog box, the last viewed composite is now automatically selected

Profile Manager
“Use Building Material” checkbox renamed to “Override Surfaces” to better match Tool Settings and to be clearer – the on/off has been reversed to accommodate the name change.
SMALL INTERFACE CHANGES

Scheme Settings

- Data in the IES Schemes panel can be sorted by ID or Name
- Scheme Settings redesigned to better match similar dialogs and to combine New/Duplicate functionality
- In the Fields panel, use Cmd+A (select all) shortcut to select all fields
- Additional Parameters moved into sub-dialog, with a list view of the parameters and instant Search
- Use Shift and/or Cmd to multi-select, multi-edit, multi-delete, and multi-drag fields
- The Criteria control “is/is not/contains” (e.g. for Building Material Name), now also includes “does not contain”

Wall’s End Surface Pattern

When the “End Surface: Override using Adjoining Wall” is checked, the texture and vectorial hatch are now correctly aligned with the neighboring Wall (if you realign texture of neighboring Wall, the neighboring Wall’s end will match it).

Find & Select Surface Criteria

In the Find & Select dialog box, the “Surface Override” criterion has been changed to just “Surface”, and will search for the Surface regardless of whether it’s an override or the original Building Material surface.

Commands of the Window Menu

Commands have been renamed/changed to fit Tab Bar workflow

Navigator Palette

- “Auto Hide Navigator/Organizer” command has been removed (from context menu of Navigator/Organizer), due to the introduction of the popup Navigator in the Tab Bar
- Navigator and Organizer pop-up can now hide as well as show relevant palettes

Work Environment

- New menu command to change Work Environment Profile: Options > Work Environment > Apply Work Environment Profile
- Guide Lines Panel eliminated from Work Environment Settings
- Simplified Guide Lines settings are now found on the renamed Input Constraints and Guides Panel
- Imaging and Calculation Panel renamed to Model Rebuild Options.
  - Includes the Auto-rebuild Model View Control (formerly located on the More Options panel)
- Palette Schemes group has been renamed to Workspace Schemes
Tool Settings Panels

- The Listing and Labeling Panel is now called just Listing, and is hidden by default. (You can make it appear in Tool Settings, by customizing your Work Environment.)
- The Relation to Zones control (formerly on the Listing and Labeling Panel of Wall, Column and Curtain Wall Settings) has been moved to the Model panel (Wall and Column Settings) and the Member Placement Panel (Curtain Wall Settings).
- In Zone Settings: the Undo Top Crops/Undo Bottom Crops command is now called Undo All Crops, and has moved to Design > Roof Extras.
- The Parameters for Listing tab (in Object-type Tool Settings) is now called Descriptions

Other UI modifications

- OSX10.10 only: dialog panel headers and pop-ups now flatter in design (fewer gradients) to fit better with Yosemite style
- SEO palette is narrower and width can be stretched